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Preface

© 2019 Vector Informatik GmbH - All rights reserved - https.//www.vector.com/ - This material
may not be reproduced, displayed, modified or distributed without the express prior written
permission of the copyright holder. Squore is protected by an Interdeposit Certification registered
with Agence pour la Protection des Programmes under the Inter Deposit Digital Number
IDDN.FR.001.390035.001.5.P.20173.000.70600.

Foreword
This edition of the Eclipse Plugin Guide was released by Vector Informatik GmbH.

It is part of the user documentation of the Squore software product edited and distributed by
Vector Informatik GmbH.

If you are already familiar with Squore, you can navigate this manual by looking for what has
changed since the previous version. New functionality is tagged with (new in 19.0) throughout this
manual. A summary of the new features described in this manual is available in the entry * What's
New in Squore 19.0? of this manual’s Index.

For information on how to use and configure Squore, the full suite of manuals includes:

User Manual Target Audience

Squore Installation Checklist New users before their first installation

Squore Installation and Administration Guide IT personnel and Squore administrators

Squore Getting Started Guide End users, new users wanting to discover
Squore features

Squore Command Line Interface Continuous Integration Managers

Squore Configuration Guide Squore configuration maintainers, Quality
Assurance personnel

Squore Eclipse Plugin Guide Eclipse IDE users

Squore Reference Manual End Users, Squore configuration maintainers

Squore API Guide End Users, Continuous Integration Managers

Squore Software Analytics Handbook End Users, Quality Assurance personnel

Q You can also use the online help from any page when using the Squore web
interface by clicking ? > Help.

Licence

No part of this publication may be reproduced, transmitted, stored in a retrieval system, nor
translated into any human or computer language, in any form or by any means, electronic,
mechanical, magnetic, optical, chemical, manual or otherwise, without the prior written
permission of the copyright owner, Vector Informatik GmbH. Vector Informatik GmbH reserves
the right to revise this publication and to make changes from time to time without obligation to
notify authorised users of such changes. Consult Vector Informatik GmbH to determine whether
any such changes have been made. The terms and conditions governing the licensing of Vector
Informatik GmbH software consist solely of those set forth in the written contracts between
Vector Informatik GmbH and its customers. All third-party products are trademarks or registered
trademarks of their respective companies.

Warranty

Vector Informatik GmbH makes no warranty of any kind with regard to this material, including,
but not limited to, the implied warranties of merchantability and fitness for a particular purpose.
Vector Informatik GmbH shall not be liable for errors contained herein nor for incidental or


https://www.vector.com/
../prerequisites/index.pdf
../install_admin_manual/index.pdf
../getting_started/index.pdf
../cli_reference/index.pdf
../configuration_manual/index.pdf
../eclipse_plugin/index.pdf
../reference_manual/index.pdf
../api/index.pdf
../swan_handbook/index.pdf

consequential damages in connection with the furnishing, performance or use of this material.

This edition of the Eclipse Plugin Guide applies to Squore 19.0.17 and to all subsequent releases
and modifications until otherwise indicated in new editions.

Responsabilities

Approval of this version of the document and any further updates are the responsibility of Vector
Informatik GmbH.

Contacting Vector Informatik GmbH Product Support

If the information provided in this manual is erroneous or inaccurate, or if you encounter problems
during  your installation, contact Vector Informatik GmbH Product  Support:
https://support.squoring.com/

You will need a valid customer account to submit a support request. You can create an account on
the support website if you do not have one already.

For any communication:

- support@squoring.com

« Vector Informatik GmbH Product Support

Squoring Technologies - 76, allées Jean Jaurés / 31000 Toulouse - FRANCE

Getting the Latest Version of this Manual

The version of this manual included in your Squore installation may have been updated. If you
would like to check for updated user guides, consult the Vector Informatik GmbH documentation
site to consult or download the latest Squore manuals at https://support.squoring.com/
documentation/latest. Manuals are constantly updated and published as soon as they are
available.


https://support.squoring.com/
https://support.squoring.com/documentation/latest
https://support.squoring.com/documentation/latest

Chapter 1. Introduction

This document is the Eclipse Plugin Guide for Squore.
Its objective is to guide you through various aspects of the Squore Eclipse Plugin:

« Introducing the Squore Eclipse Plugin positions the Squore Eclipse Plugin inside the Squore
ecosystem, explaining its main features.

« Installing and setting up the Squore Eclipse Plugin describes the steps to follow in order to
install the Squore Eclipse Plugin.

« Getting Started With the Squore Eclipse Plugin walks you through the features provided by
the Squore Eclipse Plugin.



Chapter 2. Introducing the Squore Eclipse
Plugin

Squore Eclipse Plugin in the Squore ecosystem

Squore analyzes projects (in a broad sense) to provide high level indicators and produce
personalised dashboards and tailored action lists for each kind of connected user. The whole
process can be automated, and integrated in a continuous integration framework.

Information generated in this fashion can be refreshed with any desired rate, and the results will
be available each time the Squore process concludes a new build. However, this scenario is best
suited to a daily cycle at most, where all input files are the result of a daily commit, and results
are generated along with the nightly build.

The Squore Eclipse Plugin is destined to operate at a faster rate, the objective being to deliver
results during the development process, before files are committed and fed to the continuous
integration process. Tightening the processing loop has several consequences for the Squore
Eclipse Plugin behavior:

« It doesn’t need to be connected to a central Squore server to rate a project, unless for project
activation / licence validation purposes.

By limiting communication with the server to a minimum, we make sure projects can evolve
outside the global rating cycle, but still offer the rating service.

Should the server be unreachable, rating service is still available for a whole week, before
being deactivated. Once a connection is available again, and the credentials are validated, the
rating capabilities are restored.

« It must be able to process and rate a project locally

The Squore Eclipse Plugin runs the Squan Sources static code analyser on the sources in your
Eclipse project.

Note that no other data provider is run by the Squore Eclipse Plugin, so the overall rating of
your project may vary from the one obtained when analysing the same for the same code
base on Squore Server. Metrics and violations returned by Squan Sources will nevertheless be
the same.

« It must use a configuration (in terms of Analysis Model and Data Providers) synchronised with
the one installed on Squore Server

Since the Squore Eclipse Plugin uses a Squore rating module, it needs a rating environment,
which must be synchronised with the server's, to ensure results equivalence.

The Squore Eclipse Plugin will perform such synchronisation during the product activation,
which is a feature available in the Squore Eclipse Plugin preferences page.

« It must be able to manage projects using other languages than Java (e.g. C, C++, C# Ada)

The Squore Eclipse Plugin benefits from the Squore source code analyzer, which provides
support for several languages (see Squore documentation for more details).

Analysis results will be available at folder and file level.
« It must be integrated into the Eclipse IDE, taking advantage of its extendability
The Eclipse plugin development framework offers a number of mechanisms to enhance

various parts of the IDE.The added features have been designed to be both unobtrusive and
informative.



« It must enhance a project’s available information by displaying ratings, Action Items, Findings
and highlights for each compatible object

The added information is assigned to each artefact, which means at project, file, module, class
and function level. Each of these elements will have a rating, as well as a list of Action Items
and Findings, depending on the model. A search view offering project artefacts sorted by
rating is also available.

« It must be able to manage local versions, which are dissociated from the source code control
versioning mechanism

One of the differences between the Squore Eclipse Plugin and Squore is that Squore Server
uses a database to store the project builds across multiple versions, whereas the Squore
Eclipse Plugin uses a local file storage mechanism, to maintain a local history.

This allows functions such as DELTA_VALUE or PREVIOUS_VALUE to work as expected, and
produce trend analysis indicators.

Trends are based on the evolution of indicators between a baseline analysis and the last-rated
analysis.

Who is the Squore Eclipse Plugin destined to?

As hinted by its name, the Squore Eclipse Plugin is a developer tool. Its objective is to provide
users with enough information to help them:

« Process the generated list of Action Items

« Check the evolution of the source code rating as it is being produced

« Find what artefacts are responsible for a poor rating, and understand why

« Anticipate and address problems that will appear in the project’'s daily Squore server build

before the code is referenced in a SCM system

As the Squore Eclipse Plugin seamlessly integrates Squan Sources results in the IDE, and uses the
same model as the one on Squore Server, developers will gain visibility over the evaluation
process, and improve their development practices to match the standard defined by the model.

The integrated rating feedback also gives the developer the opportunity to actively participate to
the global effort on quality improvement.



Chapter 3. Installing and setting up the Squore
Eclipse Plugin

Installation Prerequisites

Supported Operating Systems

The following is a list of the officially supported and tested operating systems:

CentOS 6.7

CentOS 7.3

Ubuntu 18.04 LTS
Windows 10
Windows Server 2016

0 A 64-bit version of the OS is required

The following is a list of the operating systems that are not regularly tested but are known to be
working:

Red Hat Enterprise Linux 6
Red Hat Enterprise Linux 7
Fedora 29

SuSe Linux 11.1

Ubuntu Server 16.04
Windows 7

Windows 8

Windows Server 2008 R2
Windows Server 2012 R2

For All Systems

For a successful installation of Squore, you will need:

The Oracle Java Runtime Environment version 8 (other versions are not supported)
A supported Eclipse version (Luna SR2 and up)

Valid credentials to log into a Squore Server

At least 4 GB of space available on the disk for a full installation with demo projects
At least 8 GB of RAM on the server machine

At least 4 GB of RAM on the client machine



Keep in mind that the requirements above are the strict minimum. In production,
Squore Server generally runs on a dedicated machine. A performant
configuration is usually:

+ 16 threads CPU.

« 64GB of RAM.

Q « SSD hard drives.

Squore reserves 25% of the available RAM of the machine to the database and
another 25% to the server. External processes (like Checkstyle or FindBugs)
running on the same machine as Squore may add to the amount of RAM required
for analysing source code. Linux is known to offer better performances than

Windows when running Squore. For a production database, you should plan a
minimum of 20 GB of disk space.

Packages for Windows

A compatible version of Eclipse must be downloaded from http://www.eclipse.org/downloads/ .

Packages for CentOS and Red Hat Enterprise Linux

On Red Hat Enterprise Linux and CentOS (6.5 and 7.1), the dependencies are satisfied by the
following packages:

Mandatory packages:

- java-1.8.0-openjdk
. perl

- perl-Date-Calc

- perl-Digest-SHA

- perl-JSON

« perl-libwww-perl
« perl-Time-HiRes

» perl-XML-Parser
- fontconfig

. tcl

« A compatible installation of Eclipse downloaded from http://eclipse.org/downloads .

For more information about how to install the Extra Packages for Enterprise Linux (EPEL)
repository, consult https://fedoraproject.org/wiki/EPEL.

Packages for Ubuntu

On Ubuntu 16.04.3 LTS, the dependencies are satisfied by the following packages:
Mandatory packages:

- libdate-calc-perl

« libhttp-message-perl
« libjson-perl

« libwww-perl

« libxml-parser-perl


http://www.eclipse.org/downloads/
http://eclipse.org/downloads
https://fedoraproject.org/wiki/EPEL

« openjdk-8-jre
- perl
. tcl

« A compatible installation of Eclipse downloaded from http://eclipse.org/downloads

Packages for other Linux distributions

On Linux platforms, the following must be installed before installing Squore:
« Perl version 5.10.1 or greater including the following extra-modules:

o Mandatory packages:
m Date::Calc [module details]
= Digest::SHA [module details]
» HTTP::Request [module details]
= JSON [module details]
s LWP [module details]
» LWP::UserAgent [module details]
= Time::HiRes [module details]

s XML::Parser [module details]

If some of these modules are not available as packages on your operating

Q system, use your perl installation’'s cpan to install the modules. Using the OS
packages is recommended, as it avoids having to reinstall via cpan after
upgrading your version of perl.

« Tcl version 8.5 or greater,

« A supported Eclipse version (Luna SR2 and up)

Squore Eclipse Plugin installation

The Squore Eclipse Plugin complies with the Eclipse requirements, and is an OS-independent
package to be deployed in the Eclipse plugins directory. Installation is done through an update
site.

In order to launch analyses, the plugin needs to use an installation of perl and

Q tclsh. If you are using a Windows operating system, the easiest way to install
both dependencies is to install the Squore CLI package on your machine following
the procedure outlined in the Command Line Interface manual.

« Create a new update site within Eclipse

o Select Help > Install new software;.

o Click on Avdilable Software Sites;.

o Add a new site;

o Give it a name (for example: "Squore Eclipse Plugin");

> Set the location to http://localhost:8180/SQuUORE_Server/eclipse
« Go back to the "Install" window with the "OK" buttons;
« Select the newly created update site;

« Proceed with the plugin installation as with any Eclipse plugin.


http://eclipse.org/downloads
http://search.cpan.org/~stbey/Date-Calc/lib/Date/Calc.pod
http://search.cpan.org/~mshelor/Digest-SHA/lib/Digest/SHA.pm
http://search.cpan.org/~gaas/HTTP-Message/lib/HTTP/Request.pm
http://search.cpan.org/~makamaka/JSON/lib/JSON.pm
http://search.cpan.org/~ether/libwww-perl/lib/LWP.pm
http://search.cpan.org/~gaas/libwww-perl/lib/LWP/UserAgent.pm
http://search.cpan.org/~zefram/Time-HiRes/HiRes.pm
http://search.cpan.org/~toddr/XML-Parser/Parser.pm
http://localhost:8180/SQuORE_Server/eclipse

« To speed-up installation procedure, it is possible to uncheck "Contact all
update sites during install to find required software", as no external software
0 is needed by the Squore Eclipse Plugin.

« Should the plugin fail to deploy, Eclipse will notify the user of the problem
cause, and will start its operations as usual. If necessary, copy and send the
generated Eclipse log to support@squoring.com.

Squore Eclipse Plugin setup

To use the Squore Eclipse Plugin, it must be activated, the server must be reachable with proper
credentials, and rating preferences must be provided.

All these operations are accessible through the Window > Preferences > Squore page. Note that
all provided information uses the Eclipse secure storage.

o,

LK
| type filter text || Squore oo v ow

G | ~

4 AE:EE General settings for Squore Eclipse plugin

» An

> Cloud Foundry Envirenment configuration

5 Code Recommenders Perl binary path: | Chclivtools\perhperhbinyperl.exe |

» Data Management Tel binary path: | Ci\clittoolstelshi\bin\tclshg5.exe |

» Help

» Install/Update Server connection

» lava

. Java EE Server url: | http://localhost:8180/5CuORE_Server |

» lava Persistence Check Server | Server is unreacheable

s JavaScript

» JSON User connection (opticnal)

5 Maven User logi | r |

» Mylyn ser login: ema

» Oomph User password: |""""""""" |

» Plug-in Developrment - .

, Remote Systems Check User Server is unreacheable.

» Run/Debug

» Server | Import Configuration from Server | (Unsynchronised) Use to retrieve environment from the server.
Squore

» Team

» Terminal
Validation

. Web v |R5tcrre Qefauﬂs| E Apply i

@ . ok || Cancel |

The Squore Eclipse Plugin preferences page

Fill in the paths to the perl and tclsh executables and the server details and click Check Server to
ensure that your configuration is correct.

If you can successfully connect to the server, click Import Configuration from Server to
synchronise your environment with the one from Squore Server.

When the synchronisation finishes, click OK to close the preferences window.


mailto:support@squoring.com

Chapter 4. Getting Started With the Squore
Eclipse Plugin

Launching Your First Analysis

Once the Squore Eclipse Plugin is installed in Eclipse, obtaining a rating for your project is rather
straightforward.

First locate the Squore contextual menu entry for the project you want to rate.

i Squore » Build
;§*~" Refresh F5 Build and Baseline
Close Project

Clean

Close Unrelated Projects Build Automatically

e Build Configuration...

Contextual menu on an Eclipse project

Rating (or "building") a project with Squore Eclipse Plugin can either be performed as a baseline
build or a draft build

« When choosing baseline build, the project rating will produce a new reference version, with
which all subsequent ratings will be compared to. This will affect rating computations based
on metrics previous values, as well as all trends displayed in the Squore Eclipse Plugin views.

The baseline mode is useful when a stable state of the project has been reached, and a
development phase is about to begin.

« When choosing draft build, the project is rated as usual, but the reference version is not
modified. Each new draft build overwrites the previous analysis and displays trends and deltas
relative to the last defined baseline.

The draft mode is useful during a development phase, when the project can undergo several

back and forth changes, and the user wants to keep comparing the current version to the last
stable one.

Before you can build a project, you first need to define its build configuration:

10



E Squore Build Configuration (kaptcha) >

Load project parameters from:

(®) Wizard

() Server Project

Key Value

o

The Build Configuration screen

On the Build configuration screen, you can choose an analysis model for your project, or you can
select the project on the server that corresponds to the code you are working on locally. By

selecting an existing project, you can retrieve the project attributes from the server, and therefore
run your local analysis in the same conditions as it is run on the server.

1



E Squore Build Configuration (kaptcha *
Load project parameters from:

() Wizard AMALYTICS

(®) Server Project | kaptcha (software_analytics) =
Key Value

APPLY_TO_BE_TESTED 1.0

COV_BRAMNCH_A 0.0

COV_BRAMCH_E 100.0

COV_BRANCH_C 100.0

COV_BRAMNCH_D 100.0

COV_MEDC_A 0.0

COV_MCDC_B 0.0

COV_MCDC_C 0.0

COV_MCDC_D 100.0

COV_STAT_A 100.0

COV_STAT B 100.0

COV_STAT_C 100.0

COV_STAT_D 100.0

LEVL_THRESHOLD 4.0

PATH_THRESHOLD 5.0

Project options for the kaptcha project on the server

Click OK to close the configuration dialogue. You are now ready to start building your project
using the draft or baseline submenu in the Squore Eclipse Plugin context menu.

folders and individual files as well. Go to the Squore contextual menu of the

ﬂ With the Squore Eclipse Plugin, in addition to projects, you can build folders, sub-
desired item (right click) and click build, just like a project.

Visualising Analysis Results

After your analysis completes, switch to the Squore perspective to view the results.

Q Click Window > Perspective > Open Perspective > Other and search for Squore in
the list of available perspectives if you are using it for the first time.

The Squore perspective displays various views with information relative to the file or folder you
click in the Project Explorer.

12



E workspace-neon - Squore - kaptcha/src/java/com/google/code/kaptcha/core/FishEyeGimpy.java - Eclipse — O x

File Edit 5ource Refactor MNavigate Search Project Run  Window Help

N-EHRIPACRIE B4 -0 QBB P iE T PO D Quickacees] | 15 | 22 & [
roject lorer [} | DefaultMois 1S impy.java
[ Project Expl Bt E|<‘|='T> ¥ =0 DefaultMoi ] FishEyeGimpy.j x4 = 0
wv [ kaptcha #% 1 package com.google.code.kaptcha.core; ~
[=}
» i JRE Systern Library [JavaSE-1.2] 2
v B s 4 Y :'{-' import java.awt.Color;[] =
=a
v [ java oS f*
~ [ com 1@ * {@link FishEyeGimpy} adds fish eye effect with vertical and horizontal lines.
w [ google 11 */
v (= code # 12 public class FishEyeGimpy implements GimpyEngine
v [ kaptcha 12_ i o
v (= core 15 * Applies distertion by adding fish eye effect and horizontal vertical
DefaultBackground 16 * lines.
DefaultKaptcha,javi 17 *
DefaultMoise,java 18 * [@param baseImage the base image
- - - * @return the distorted image
FishEyeGimpy java . wp
MoNoisejava i 215 public BufferedImage getDistortedImage(BufferedImage baseImage)
ShadowGimpy.java 22 {
WaterRipple java 23 B
5 = impl 24 Graphics2D graph = (Graphics2D) baseImage.getGraphics(); o
ac Tt dmmmnlUnd mlhd o s m T s madUAd Al Y
b = servlet
» o text
S = util il Squore Card 52 | iy Action ltems 4l Findings i Highlights & Console = O
5 [ resources FishEyeGimpy.java
%] checkstylexml
%] findbugs.xml D
X] pmd.xml Measures/Indicators Value 6
Line Count 126 [/ |
Source Lines Of Code 73 ﬂ
Effective Lines Of Code 51 [/ |
Executable Statements 42 ﬂ
Cyclomatic Complexity 12 [ |
Complexity Distribution
Ratio of complex modules 8.3% C|
MNumber of Modules 3 B
Class Complexity Ratio 0.0%
Mumber of Classes 1 ﬂ
Coding Rules Compliance
< > Rule Compliance 90.68% v

A | [aloe 7

The Squore Perspective with the Squore Card, Action items, Findings and Highlights views in the bottom
panel

Click a file or folder in the Project Explorer and use one of the following views in the bottom panel
to understand your rating:

« The Squore Card view displays the overall rating for the current artefact, and its trend. It

also lists the tables of interests for this artefact, as defined in the Analysis Model used to rate
the project.
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e Squore Card 57 | iy Action ltems gl Findings &k Highlights [E) Console

FishEyeGimpy.java

D

Measures/Indicators Yalue

126 a
Source Lines Of Code 73 ﬂ
Effective Lines Of Code 51 B
Executable Statements 42 ﬂ
Cyclomatic Complexity 12 a
Complexity Distribution
Ratio of complex modules 8.3% C|
Murmber of Modules 3 ﬂ
Class Complexity Ratio 0.0% A
Mumber of Classes 1 ﬂ
Coding Rules Compliance
Rule Compliance 99.68% A
Mon Conformity Count Ewviclations a
Mon Compliant Standards 2 rules a3
Coding Standards £18 rules [ |
Issue Distribution
Blocker |ssues 0 ﬂ
Critical [ssues 0 ﬂ
Major lssues 0 a
Minor lssues B ﬂ

The Squore card

The Findings view lists the Findings for the current artefact as well as underlying artefacts,
with their location and definition details. This list can be sorted, and allows navigation to
artefacts associated to each finding by double-clicking on their name.

pabkblic tne I} |
knt 1 = ¢

i=1/ar

if 1 == ) §
ﬂ maturn 17

(CECUORE] A functeon shall harve a single point of exit at the ervd (see [MISRA-C2004) RULE 147).) =

retorn 13
| | ]
String[] gechshrray|Collsccicn<Strings o) §
il retorn (STringll) c.toRrcrayid:
K W
[ElF @ Jwador (4 Declaration =g Frogress | b Findings B0 dh sctiontems 8] TaskList ' B

T jarra (Tedalk 3; Minas 3)

brefact Line  Fude Practice Wew 0P He
[gethshermyiollection<Strng=1 21 Class Cast Boception 'Wikh ., This usage of the Collection toferag() method will throw s ClassCasiEsception, true  SOUORE Fis
gethsleradCollection<Srmg»] 21 B Imposskle downeast . This code i casting the result of calling bodirey() on a collectionts s bype mom specifi,.,  true  SCUORE R
F 14 Felukiple exits & function shall haee a single port of it et the end (ses [MISEA-C200<T RULE 14.7), true  SCUORE Mo
£ *

A finding and its location in the source code



String[] gechsirray|CollectioncScrings cj [
{4 [Mukiple markers 2t this line

- (SCOUGRE] This wrage of the Collection tolimey(} methed wall thiow a ClessCastEsception,

- (SOUCRE] This code is caby the nesul of calling tofimay on g cellectionbs o bype mone specife: thae Dbpect]] | a5 e Sting|] geiAotmay ICollectin<Siing> <)
{ retum (String(]} ctodneesdl; § This wil usuelly fail by throwing & ClassCastException. The tofaray) of elmeost all cobections return an Qbject]]. They can't really do anything L
elsesince the Collection chject han ne relerence ba the declared gereric type of Ehe collestion. The comect way ba do get e aray of & specific bype from a sollestion i to use
cAoAmayines Stnnglll or ctefrayines Streglcsize0l (the latter is shghbly mare effecient). There is one common/knows eeption exception te thes. The todiray]) methed of
lists returmed by Smays. eslist(,..) will retum & covarizntityped smay, For example, Smays astneyines Stringl] { ‘e’ fibodinmey) will rebum 2 String [] . FindBugs sttempts to detect

| and puppreseioch cave, but may min wome

A finding full description

« The Action ltems view works much like the Findings one, except it lists the Action Items
computed by the Decision Model, and the reason why they have been generated.

f. Problems @ Javadoc |1 Dedlaraton S5 Frograss dFindings  Jh adion kems 52 5] TaskList =8
Testjava (Totak 3]

Artefact I Fame Srope Sepbuz  Ressons F\'ic.ui‘ty
) ﬂépﬁur_.n:,-_l",',_u&u_hsn_-:ﬁ_._' -3-510  Mumber of Blacker and crical nde increaied [Fercticn]  OPEM  Few arefact should be ecieed dus bo.. High
getffimey{Collection<S.. -3-51.2 Mo Blocke rule [Fercticn] OPEM  ‘Blocker ndex (=] detected infumcticn. High
getfefimey{Collection<5..  -3.-51.1  Mumker of high snd major nde increased [Farction]  OPEM  Few Adedect should be reviewed die in..  Bed...

Action I[tems

« The Highlights view works much like the Findings one, except it provides a list of the current
project's Files, Classes or Functions, sorted by decreasing rating. Selecting the type of object
to sort (File, Class or Function) is performed through the top-left menu icons.

i Problems @ Javadoc [2 Declaraion & Console J Highlights 52 | Jl Findings
Test worst methods (Total: 171)

Artefact Line
doXMLFinding [ 30
endElement E 570
getlocStr [4 s
startElerment E 349
CoreArtefact (1 76
addData B Rk
addDefectReports E 115
addDefectReports @ 219
addDrLinksTestsDependencies E 55
addInformation E 439
addLocation E 56
addLogicalFatherstr [ 22
addSon (] 428

Highlights

Only the highlights created for the role PLUGIN are displayed in Eclipse. For
Q more information about configuring highlights in your model, refer to the
Configuration Guide.

Exporting Analysis Results

If you need to share your analysis results, it is possible to export the highlights as well as the
squore card into a CSV file.

For example, go in the Highlights view, choose your highlight in the drop-down list and click export

15



ély Squore Card  glly Action tems gl Findings | &% Highlights 32 | & Console

src (Total: 14)

Technical Debt V| || Exprg

Artefact Line  Own Technical Debt

sre/commaonyThreeCheckBoxPr... 129 1 hour 10 minutes
74 27 minutes
119 43 minutes

sre/commen/UnicodeReader.ja...
sre/commen/OptionalDontshe...
sre/commen,/UnicodeReader,ja... 11 minutes

17 minutes 30 seconds

b4
sro/commen/EmlBinding Tools,.. 108
a8 T minutes 30 seconds
a4
50

sre/commen/CeolorProperty.jav..
sre/commen,/FontProperty.java... 10 minutes
sre/commen/Mamed Object.jav... 10 minutes
100 7 minutes 30 seconds
116 30 minutes
74 20 minutes
a3 20 minutes
142 10 minutes

165 20 minutes

sre/commen,/CptionalDontShe...
src/commen/ThreeCheckBoxPr..,
sre/commen/XmlBindingTools,j...
sre/commen/XmlBindingTools.j...

sro/commen/EmlBinding Tools,..

(> 1> 1> 1> 1>1>1>1>1>lolololo)

sre/commen/EmlBindingTools,j...

Highlights Export Button

Choose the name and folder path of your CSV export file :

E Open

« v P <« Downloads » HighlightsExportFolder v O
Organize = Mew folder
Marne B Date modified Type

Mo itermns match your search.,

File name: | myHighlightExportFile.csv

Highlights Export File Dialog

You can then open your CSV file and work on your data :
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YViolations Dens...

8,922 Pt=/KLoc
9 Pts/KLoc
5 Pts/ElLoc
50 Pt=/KLoc
4 Pts/KLoc
0 Pts/KLoc
11 Pts/ELoc
20 Pts/KLoc
0 Pts/KLoc
38 Pts/KlLoc
33 Pts/KLoc
33 Pts/KLoc
9 Pts/KLoc
22 Pts/KlLoc

Block...

[ R e Y e e RN e R e T e e e T e e T e e T e

[T = = I = Y = R N = R O = T T = T T = T Y

Search HighlightsExportFolder

m @

Size

* A

-

Cancel

Critic...

ot



A B C D E F G

1 |Artefact Rating Line Own Technical Debt Violations Density Blocker Issues Critical 1ssues

2 |src/common/ThreeCheckED 129 1 hour 10 minutes 8,922 Pts/KlLoc 0 4
3 |sre/common/UnicodeReac C 74 27 minutes 9 Pts/KLoc 0 0
4 |srg/common/OptionalDon B 119 45 minutes 5 Pts/KLoc W] 0
5 |src/common/UnicodeReac B 64 11 minutes 50 Pts/KLoc 0 0
& |src/common/XmIBindingT B 108 17 minutes 30 seconds 4 pts/KLoc 0 0
7 |src/common/ColorPropert A 88 7 minutes 30 seconds 0 Pts/KLoc W] 0
8 |src/fcommon/FontProperty A 84 10 minutes 11 Pts/KLoc 0 0
9 |src/common/NamedQbjecA 50 10 minutes 20 Pis/KLoc W] 0
10 |src/common/OptionalDon A 100 7 minutes 30 seconds 0 Pts/KLoc W] 0
11 |sre/common/ThreeCheckE A 116 30 minutes 38 Pts/KLoc 0 0
12 |sre/common/XmIBindingT A 74 20 minutes 33 Pis/KLoc W] 0
13 |src/common/XmiBindingT A 83 20 minutes 33 Pts/KLoc 0 0
14 |src/common/XmIBindingT A 142 10 minutes 9 Pts/KLoc W] 0
15 |sr/common/XmiBindingT A 165 20 minutes 22 Pts/KLoc W] 0

Highlights CSV Export File Example

17



Index

A
Action Items view, 15

B
Baseline build, 10

D

Disk Space, 6
Draft build, 10

F
Findings view, 14

H
Highlights view, 15

J
Java, 6

M
Memory, 6, 6

P
Prerequisites, 6

S
Squore Card view, 13
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